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Introduction

Welcome to The Gateway Comics and Illustration section for 
the 2011/2012 publishing year! 

I’m Ross Vincent, Design and Production Editor (a high-fa-
lutin’ way of saying I’m in charge of the comics). I’ve been 
volunteering for the comics section for a few years and I’m 
always happy to share my knowledge and experience with 
new volunteers. This manual will let you know the ways you 
can contribute your artistic talents to the paper, including a 
step-by-step guide to making comics plus a few tips to help 
you avoid the mistakes made by many beginners (myself  
included).

So sit back, relax, and let this guide be a swirling dimension-
al portal into the world of newspaper illustration.

Interesting Facts

The Gateway office is located:
Suite 3-04, Students’ Union Building (SUB)
University of Alberta Campus

Meetings: Tuesdays at 3:30 p.m., The Gateway couch room

Deadline for comics: Monday at 1:00 pm

Comics dimensions: 
Strips — 10” x  2” 
Single-panel — 3.5” x 5” 
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Why volunteer to 
make Comics?

Simple: because it’s fun.

Okay fine, there’s much more to it, but fun 
is a big part of volunteering. If you need 
more reasons, here are some of the best:

It looks great on a resume to have •	
published art.
It allows you to hone your artistic •	
skills, or develop them from scratch.
Develops professional skills, such as •	
meeting deadlines and working with 
editors.
Exposure: your work will be seen by •	
thousands of readers on campus and 
online.
Travel opportunities: The Canadian •	
University Press, of which The Gate-
way is a member, hosts journalism 
conferences twice yearly that inter-
ested volunteers can attend. These 
are great ways to learn more about 
journalism, network with industry 
professionals, or simply party with 
your Gateway buddies in some far-
away land.
You get to hang out with fellow illus-•	
trators (who are always the most fun 
of all Gateway volunteers).
Campus experience: It’s a great feel-•	
ing to volunteer and be a part of 
something bigger than yourself. Take 
it from me that volunteering and get-
ting more involved in campus life lets 
you get the most out of your univer-
sity experience.

How can I volunteer?

The best way to get involved is to come 
to Comics section meetings Tuesdays at 
3:30 pm. That’s when I give out any as-
signments and can hear your pitch for 
comic ideas or give you feedback on stuff 
you’ve drawn. The following are some of 

the illustrations we use in the paper:

Comics: The bread-and-butter of the Com-
ics & Illustration section is, unsurprising-
ly, comics. The standard comic is 10” wide 
by 2” tall. See HOW TO MAKE A COMIC to 
learn more.

Single-Panel Comics: We also print com-
ics that are only one panel akin to syndi-
cated comics like Bizarro and The Far Side. 
The dimensions are roughly 3.5” wide by 
5” tall.

Editorial Cartoon, or “Edtoon”: These 
appear on the first page of the Opinion sec-
tion, typically poking fun at a public figure 
and/or current event. The dimensions 
vary but are usually within the realm of 7” 
by 7”.

Edtoons need to be done on press night 
so I usually give this out at the comics 
meeting. Both the topic and final drawing 
need to be approved by the Opinion Editor, 
Ryan Bromsgrove. You don’t need to have 
an idea for the edtoon to draw it; Ryan and 
I will help you brainstorm ideas until we 
settle on something good.

Drawing edtoons is a great way to im-
prove your skills as an artist. You may nev-
er have thought to draw Indira Samarasek-
era or Rory Tighe, let alone the two of them 
making out, but forcing yourself to draw 
things you wouldn’t normally draw is the 
best way to improve. As an added incen-
tive, edtoons are in a very high-profile lo-
cation in the paper and get lots of reads.

Features: We often require illustrations to 
go with our weekly feature, depending on 
the topic and theme of the piece. These are 
planned well in advance so artists will have 
plenty of lead time to work on it. Depend-
ing on the size of the piece, more than one 
artist may be needed. Feature illustrations 
can vary from drawing specific images to 
allowing you free reign to create what you 
want so long as it’s in keeping with the 
theme and tone of the article.

Random Assignments: Occasionally I get 
last-minute requests from other editors for 
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an illustration to go with an article. These 
need to be done on press night and will be 
given out at the comics meeting. 

How to make Comics

If you’re interested in writing comics but 
have no idea where to start, below is a step-
by-step guide for the quickest way to draw 
a comic that’s ready for print, beginning 
with what you’ll need to do the job. How-
ever, this is by no means the only way to 
do comics; as you become a more experi-
enced artist you will find your own ways of 
doing things as well as tools and methods 
that work best for you, and I encourage 
you to experiment and develop your own 
style. Until then, however, this is a good 
way to get started.

Tools of the Trade

Comic artists use a variety of implements 
in their craft, many of them specialized to 
the task. Luckily, most of them are fairly 
cheap. Here’s the rundown of the things 
you’ll need to start making comics. (NOTE: 
Almost everything listed below is available 
in The Gateway office for volunteer use, so 
you needn’t buy anything. However, I en-
courage you to buy your own tools as you 
get more involved in comic-making).

Paper: Hey, you gotta have something 
to draw your comic on. Ordinary white 
printer paper is perfectly fine for comics, 
but can’t withstand too much erasing. For 
advanced artists, I recommend smooth 
bristol, a card stock used by professional 
cartoonists. It can take a lot of erasing and 
is a good choice for long-term preservation 
of your work.

Pencils: Your primary drawing tool is the 
pencil, mainly because you can erase any 
mistakes and redraw until you get it right. 
The common HB#2 Pencil is perfectly 
fine for the job, though for finer details 
you should use a mechanical pencil with 
a 0.5 or 0.7 lead.

Eraser: The eraser is the cartoonist’s best 
friend, and not just any eraser will do. For 
most erasing tasks you need a white plas-
tic eraser, such as Staedtler Mars Plastic. 
Another useful tool is a putty or “knead-
ed” eraser, which is a squishable clay that 
is easier on paper and which you can form 
into different shapes for intricate erasing.

Pens: Cartoonists use technical or artist 
pens to ink over their pencil lines. These 
pens draw at a specific width and use a 
certain kind of ink that is ideal for comics. 
DO NOT use a ballpoint pen to ink your 
comic. 

Brush pens are used for colouring, fill-
ing in black, and drawing thicker, darker 
lines. They aren’t necessary to make a 
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comic, but they can add richness to your 
artwork. 

Artist and brush pens are typically only 
available in art supply stores, but the U of 
A Bookstore sells a decent variety of them. 
I recommend brands like Faber-Castell, 
Staedtler, and Pigma Micron.

Ruler: Whether you’re drafting your pan-
els or drawing the horizon line, a ruler 
is necessary to keep your lines straight. 
Pretty much any kind of ruler works, be it 
plastic, metal, or wood.

Fun tip: most rulers are bevelled, so you 
can draw straight lines with a pen without 
smearing the ink!

The following tools are not strictly neces-
sary but can certainly be helpful, espe-
cially if you want to use computers in your 
cartooning process.

Scanner: Scans your finished comic onto 
your computer so you can edit it and e-mail 
it to me. Also handy for scanning pencilled 

sketches and inking over them digitally.

Tablet: This tool lets you move your mouse 
cursor around by mimicking the more 
natural movement of pen on paper. Very 
handy for digital colouring and practically 
necessary for digital inking.

Adobe Photoshop: The best image-edit-
ing software available, perfect for editing, 
inking, and colouring your comics. It is 
expensive, however, so you may want to 
download GIMP, a free program that is 
similar to Photoshop.

Quick-Start Guide

Now that we’ve been introduced to our 
tools, it’s time to put them to use. Here is 
the most basic way to make a comic ready 
for print.

Step 1: Plan ahead – Before you start 
drawing, it’s a good idea to write down 
your characters’ dialogue and what’s going 
to happen in each panel. This helps you get 
a sense for story pacing, how many panels 
you’ll need, and gives you a chance to re-
vise your words before committing them 
to paper.

It’s also handy to draw a crude sketch 
of your comic, called a breakdown, as a 
guideline for word-balloon placement and 
what to draw in each panel.



7The 2011/12 Gateway Comics Guide

Step 2: Draft your paper – With your pen-
cil and ruler, draw a rectangle 10” x 2” (or 
3.5” x 5” for a single-panel comic) as your 
drawing area. Draw vertical lines to sepa-
rate the area into panels as desired. If you 
like, you can draw your panels with a com-
puter and print it out as your template. 

Fun tip: Try drawing your comic larger 
than 10”x 2”, but still conforming to the 
5:1 ratio (eg. 15” x 3”). This makes it easier 
to add fine details, and your mistakes will 
appear less obvious when it’s shrunk down 
to 10”x 2” for print.

Step 3: Pencilling – Draw your comic in 
pencil, including words and word balloons.

Step 4: Inking – With your technical pen, 
trace over your pencil lines in ink. 

Step 5: Erase the pencilling – Go over 
your comic with your eraser, getting rid of 
as much pencilling as possible.

Step 6: Add details in ink – Make any cor-
rections to your linework and add any de-
tails, such as crosshatching or shading.

Step 7: Colouring – A purely optional 
step, colouring is most easily done in 
Photoshop (see USING PHOTOSHOP), but 
feel free to use brush pens if you so wish. 
You can also “colour” in grayscale (various 
shades of gray) which shows up well on a 
black-and-white comics page.

Step 8: Send it to me – You can either give 
your comic to me in person by going up to 
the office, or you can just leave it on my 
desk (ask one of the editors’ present which 
desk it is) or in my mailbox. Alternatively, 
you can scan your comic and e-mail it to 
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me at production@gateway.ualberta.ca. 
If this is your first comic, please be sure 
to include your name and the title of your 
comic strip. Remember, the deadline for 
comics is Monday at 1 pm. After that, I 
cannot guarantee your comic will run in 
Wednesday’s issue.

And that’s basically how one makes a 
comic. Of course there’s a lot more to com-
ics than just how to draw them. Read on to 
learn a bit more about the intricacies of the 
medium.

Elements of Comics

Comics are a visual medium, yet in a quirky 
twist of fate, writing is more important 
than your art. People typically read comic 
strips to hear a good joke or an interesting 
story, and a comic that offers neither won’t 
be read. A good comic starts with good 
writing, and most of the elements of tradi-
tional narrative (beginning, rising action, 
climax) also apply to comics.

That’s not to say that art isn’t important; 
people also read comics because they’re 
visually appealing, more so than just text. 
Art conveys the action and gets readers 
emotionally involved in the story and 
characters. That said, the adage of “show, 
don’t tell” very much applies. You should 
communicate actions and emotions visu-
ally rather than explained verbally if pos-
sible. 

Character is an extremely important el-
ement in comics, as your characters are 
what your audience identifies with, there-
by making the action more compelling 
and meaningful. They needn’t be complex 
or fully-fleshed out; it’s just a weekly hu-
mour strip, after all, but your characters 
should have identifiable traits and flaws 
that determine how they act in the situa-
tions they’re in. You can use simple artistic 
cues in the look of your character to convey 
what he or she is all about.

Knowing your characters is helpful when 
writing comics, because you can put them 
in almost any situation and know how 
they’d react. A word of advice, though: DO 

Tell:

Show: Middle-aged
Refined
Old-fashioned
High class
Unimpressed
Suave
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NOT base your characters on yourself 
or your friends. Characters’ flaws make 
them interesting, but you likely won’t 
depict a character you identify with in an 
unfavourable light or risk offending your 
friends. You can use people you know for 
inspiration, but don’t make them the char-
acter. Your character should be a separate 
entity, cartoonishly exaggerated for the 
purpose of telling a story or joke.

Story needn’t be complicated with a week-
ly comic strip, but should follow some in-
ternal narrative. Your first panel often sets 
the stage for action, telling the who, what, 
where, etc., preferably through visual cues 
rather than text. The middle panels set up 
the joke, if it’s a funny comic, or otherwise 
flesh out the story leading to a payoff at 
the end. The last panel is the punchline, 
which satisfactorily concludes the action. 
In the case of larger story arcs, the last 
panel could end on a cliffhanger or a “to be 
continued…”, letting your readers know 
that there will be more to this story and en-
couraging them to read next week’s comic. 
If you do end on a cliffhanger, be sure to 
bring readers up to speed in panel 1 of next 
week’s comic. 

NOTE: Comics in a series should be able to 
stand alone, because casual readers may 
not have seen last week’s comic or not re-
member what happened. You should make 
each comic understandable to someone 
who hasn’t read the rest of the series.

Make your comic your own. It helps your 
craft to see and be influenced by other art-
ists’ work, but it’s important to develop 
your own art and writing style. Readers 
want to see work that is unique to the art-
ist and not simply a carbon-copy of some-
one else’s style. Making comics is also a 
lot more enjoyable when done so in a way 
you developed and are comfortable with. 
Your process for making comics can also 
be tweaked to your liking; this guide, for 
instance, isn’t the only way to do comics.

Content Restrictions

The beauty of volunteering for a student 
newspaper is that you have more or less 
free creative reign with your comic. Swear-
ing and the like are perfectly acceptable, 
but anything atrociously in bad taste (hate 
speech, graphic violence, disgustingly 
unpleasant things) will not be run. I may 
request you make changes to your comic 
should it not make sense, but for the most 
part, I will not edit your work aside from 
adjusting it to fit into the proper dimen-
sions and correcting any spelling mis-
takes. 

In the event that I cannot run a comic 
you submitted, I will inform you and ex-
plain why we couldn’t run it, and offer rec-
ommendations on how to make it suitable 
for print.

Using Photoshop

Below is a step-by-step guide for using 
Adobe Photoshop for various stages of 
comic making. Be warned: it’s very dry 
and procedural, so feel free to skip this  
section and instead use it as a reference 

Tough guy
Strong
Cool
Mysterious
Dumb?
Thug
Anti-hero

Young
Geeky
Quirky
Enthusiastic
Smart
Impulsive
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when you’re actually working with Photo-
shop.

Scanning

1. Turn on your scanner and place your 
comic inside, facing down, and close the 
lid. 

2. Open Photoshop, click File > Import > 
and select your scanner from the list. 

3. Your scanner’s software will pop-up and 
should automatically scan your comic. 
When finished, you should have one selec-
tion box over the image. Click and drag the 
edges of the box around your comic so as 
to crop out most of the white space. If you 
have more than one selection box, click 
on each and press “delete” to get rid of all 
but one of them, then resize it around the 
comic. 

4. If your comic is black-and-white, set the 
Color setting to Grayscale. If it is in colour 
or you plan to colour it in Photoshop, se-
lect Color. 

5. Change the dpi/ppi to no less than 200. 

6. Rotate the image if you need to. 

7. Click Finish or OK.

Now you should have your comic ready to 
edit in Photoshop. 

Making Corrections

1. Press “Z” to select the Zoom tool, right-
click on your image and click “Actual Pix-
els.” 

2. Press “E” to select the Eraser tool, and 
use it to erase any lingering pencil marks 
or other mistakes throughout your whole 
comic (Tip: holding down spacebar lets 
you click and drag with the mouse to eas-
ily scroll through the image). Make sure 
the background colour is white when you 
do this.

Saving

1. Click on File > Save as... 

2. Give it a descriptive file name so I know 
what it is and a way to distinguish it from 
other comics you’ve sent me, such as 
“ComicName_02.” 

3. Format can be JPEG, TIFF, PNG, BMP, 
PDF, or PSD. It doesn’t matter too much to 
me which format it is. 

4. Click Save. 

5. If you get a pop-up that let’s you adjust 
the image quality, put it at the highest set-
ting, then click OK.

Inking

If you choose to ink digitally, I strongly 
recommend you use a drawing tablet. 
Drawing with a mouse is very difficult and 
can look bad. Use the Brush tool (press 
“B”) when drawing because it detects the 
amount of pressure you put on the stylus, 
allowing you to vary the subtlety of each 
pen stroke. Always keep your non-drawing 
hand ready to press the undo hotkey (usu-
ally ctrl + z) to undo bad strokes. This only 
undoes the last action you made; to undo 
previous mistakes, you must go to Win-
dow > History and delete the unwanted 
actions.

Colouring

One way to add colour to your comic is by 
using the Paint Bucket Tool (“K”), which 
will fill any open field with the selected 
foreground colour. Another way is to make 
your image into a “colouring book”:

1. Click Window > Layer to open your Lay-
ers window. 

2. Right-click the “Background” layer and 
click Layer From Background. The back-
ground layer name will change, so it may 
be wise to rename it to “background.” 
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3. A window will pop up. In the Mode  
section, select Multiply then click OK. 

4. Click on the Lock icon at the bottom of 
the layer window. This will prevent you 
from accidentally colouring on your back-
ground layer. 

5. Click the Create a New Layer button at 
the bottom of the layer window. 

6. Click and drag the new layer to below 
the bottom of the layers. 

7. Select the Brush tool (“B”) and start 
drawing. You’ll notice that your colouring 
will appear underneath the background 
image, not colouring over it. I recommend 
you create a new layer for every separate 
element you are colouring (ex. skin, hair, 
sky), and remember to drag your new lay-
ers below your “background” layer. 

8. When you’ve finished colouring, right-
click on any of the layer in the layer win-
dow, then click Flatten Image. This con-
denses all your layers into a single image. 

9. Save your work.

Tips

Erasers are your friend. If something 
doesn’t look quite right, erase it and try 
again. Your art will improve if you are will-
ing to self-correct and strive to do better.

Practice. The only way to get better at art 
and writing is to keep doing it, and always 
be open to constructive criticism.

Read comics. Read as many different 
comics as you can. You may discover ele-
ments you can adapt to your own work, get 
a better sense of story pacing, and gener-
ally be inspired.

AVOID PLAGIARISM. This may seem 
odd, but this has happened before. With 
the abundance of webcomics out there, 

it’s easy to copy someone’s words and/or 
art when you’re strapped for ideas. But 
among the thousands of our readers on 
campus and online, there will definitely be  
someone who has read the original work 
and will call you on the theft. Aside from 
the legal implications for The Gateway, 
it’s embarrassing to us as a publication, 
and you will be banned from further in-
volvement with the paper. Furthermore, 
why would anyone want to plagiarize a 
comic, anyway? It’s not like you get grad-
ed on them, and why draw something 
that’s already been drawn? Precisely; it’s  
senseless.

DO NOT draw stick figures. We don’t 
expect you to be a good artist right off the 
bat, but drawing a stick figure comic tells 
me that you’re unwilling to get better at 
drawing. I’d much prefer a crude attempt 
at a human figure than a lifeless stick any-
day...wait, that sounded a bit gross ...

TRY to do a comic all by yourself. Often 
new volunteers want to write comics and 
have someone else draw them or vice-
versa, and I will certainly try to introduce 
artists to writers if you so wish. However, 
comic-making is much better if you do it 
yourself because you have total creative 
control, don’t have to rely on anybody else, 
and it allows you to develop and improve 
both your art and writing skills.

Build up a buffer early in the year. It 
may seem like you have tons of time for 
comics at the start of term, but that will 
quickly change once midterms and papers 
come along. Therefore, it’s a good idea to 
have your comics done one or two weeks in 
advance so when something does crop up 
and you have no time for drawing, you can 
still submit a comic and not have to miss 
a week.

Always keep your audience in mind 
when making your comic. It’s important 
to write and draw what you want to, but 
it’s equally important that your audience 
understands what’s going on. You should 
always ask yourself, “will people get this 
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joke?,” “is it clear what this character is 
doing in this panel?,” “do they know what 
happened last issue?,” and so forth. If in 
doubt, err on the side of bluntness.

DO NOT use Comic Sans for text. Com-
puter-generated text tends to look un-
natural in a comic, and Comic Sans is an 
especially ugly font regardless. I recom-
mend searching online for fonts specifi-
cally made for comics, or do your lettering 
by hand (which is an under-appreciated art 
form in itself).

Come to meetings! They happen Tues-
days from 3:30 - 4:00 p.m., but that 
doesn’t mean you can’t hang out earlier 
or later. Comic volunteers are always fun 
people, and it gives you a chance to meet 
your peers, bounce ideas of each other, 
and generally get more out of volunteer-
ing. Who knows, you can even pick up an 
assignment or two. (NOTE: Please pick up 
an assignment. Please?).

Further Reading

Drawing Words & Writing Pictures by 
Jessica Abel and Matt Madden. Most of 
what I know about comics comes from this 
book. A beautifully presented lesson-by-
lesson guide that takes you through the 
terminology, conception, and technical 
aspects of creating comics, complete with 
real-world examples and fun exercises.

How to Make Webcomics by Scott Kurtz, 
Kris Straub, Dave Kellett and Brad Gui-
gar. A how-to guide by professional web-
cartoonists for making compelling comic 
strips, putting them on the web and mak-
ing money off them. You can also down-
load the authors’ podcast series Webcom-
ics Weekly, which has some relevant info 
and is often hilarious.

Final Thoughts

Well, that’s the bulk of my comics knowl-
edge, nicely distilled in this handy-dandy 

guide. If you have any questions or just 
wanna talk comics, swing by the office on 
Mondays or Tuesdays or send me an e-mail 
at production@gateway.ualberta.ca and 
we can set up a time to chat in person. 

Also, be sure to come to our weekly 
meetings to hang with me and your fel-
low volunteers, and stay tuned for news of 
workshops, conferences, and comic-relat-
ed events. Hope to see you around.

Cheers,
Ross Vincent
Design & Production Editor, 2011-2012
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Notes!!
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